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Introduction

Objective
The purpose of this guide is to assist users with Word templates so that they can easily benefit from the tool’s 
various potentials for simplifying and optimising their work. This guide will help users become better acquainted 
with the functions of the Word programme, applied to the templates in use at Università della Svizzera italiana.

Purpose of the template
A template is a reference document that contains pre-defined elements, such as page layout, formatting  
and styles, which facilitate the creation and design of documents.
It saves the user a lot of time, requiring only to select and applying pre-defined elements without worrying 
about creating a layout from scratch.
The content structure also benefits and leads to an optimised presentation of communication elements.
Finally, the use of templates ensures a homogeneous, coherent, and quality presentation and consequently 
contributes to strengthening the coordinated image of the university.

Who is it for?
The templates are intended for administrative and academic staff.

Further information on the graphic design and a list of official names and editorial rules can be found  
on the USI corporate design page.

www.desk.usi.ch/en/corporate-design-templates-and-rules

For questions on the templates e-mail grafica@usi.ch

https://www.desk.usi.ch/en/corporate-design-templates-and-rules
mailto:grafica%40usi.ch?subject=
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LetterheadUse Elements layout

Università
della
Svizzera
italiana

Via Buffi 13
6900 Lugano
Svizzera

USI, Acronym or organisation 

Mr / M.me
Name Surname
Role
Address
Postal code City
Country

Name Surname
41 58 666 0000
41 58 666 4647
name.surname@usi.ch
www.usi.ch
01.01.2020

Letter subject
¶
¶
Dear Sir, Dear Madame,
¶
In order to maintain the correct graphic consistency, as well as a pleasant and clear reading 
experience, it is recommended to use the preset styles, which are available in the toolbar 
(Home  Styles or by typing Alt+Ctrl+Shift+S).
¶
“Normal” for the running text and recipient address.
“Sender” for the sender’s contact details as well as for the acronym or name of the 
organisational unit above the recipient’s address.
¶
To make a numbered list use “List”
a.  List 2
¶
Or use the bulleted list:
Bulleted List 1
  Bulleted List 2
¶
The use of other fonts or colours is not recommended.

The text is left-aligned. Please avoid hyphenation. 
For template requests, please contact corporate-design@usi.ch.
¶
¶
Best regards 
Name Surname 
Title/role
Organisational unit 
Signature

from
tel

fax
e-mail

web
date

+
+

1.

Signatures
Signatures may be
entered in electronic format

Header
-	 University
-	 University + Faculty
-	 University + Institute

All other organisational units 
shall be specified in text form 
only in the sender’s field and 
in the signature.

Subject 
Arial Bold 
size: 10 pt
spacing: 12 pt

Lines 
after subject:
2 lines
between paragraphs:
1 line
after a list:
1 line

Text
Arial Regular 
body: 10 pt
spacing: 12 pt

Setting
Please follow the 
instructions on the use 
of styles, given in the 
adjacent example.

1

5

6

7 7

6

5

3

3

Senders’s field
USI + Acronym
Where no acronym is 
available, the full name 
of the organisational unit 
is used.

Address
Arial Regular 
size: 10 pt
spacing: 12 pt

Brief overview 
of the structure of 
information on 
the various media.

The official reference list for acronyms and names is available  
at www.desk.usi.ch/en/corporate-design-templates-and-rules  
in the “Style guide, language, titles and names” section.

1 1

2 2

4 4

https://www.desk.usi.ch/en/corporate-design-templates-and-rules
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Header
-	 University
-	 University + Faculty
-	 University + Institute

All other organisational units 
shall be specified in text form 
only in the sender’s field and 
in the signature.

Word templates
user guide

Università
della
Svizzera
italiana

Document title, organisational unit, supertitle (optional)

Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor 
incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam, quis nostrud 
exercitation ullamco laboris nisi ut aliquip ex ea commodo consequat.  
¶
Title 
Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut 
labore et dolore magna aliqua. Ut enim ad minim veniam, quis nostrud exercitation ullamco 
laboris nisi ut aliquip ex ea commodo consequat. Duis aute irure dolor in reprehenderit in 
voluptate velit esse cillum dolore eu fugiat nulla pariatur. Excepteur sint occaecat cupidatat 
non proident, sunt in culpa qui officia deserunt mollit anim id est laborum. 
¶
Title 
Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut 
labore et dolore magna aliqua. Ut enim ad minim veniam, quis nostrud exercitation ullamco 
laboris nisi ut aliquip ex ea commodo consequat. 
¶
Title 
Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut 
labore et dolore magna aliqua. Ut enim ad minim veniam, quis nostrud exercitation ullamco 
laboris nisi ut aliquip ex ea commodo consequat.
¶
Title 
Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut 
labore et dolore magna aliqua.
¶
Title 
Lorem ipsum dolor sit amet; 
Lorem ipsum dolor sit amet; 
Lorem ipsum dolor sit amet. 
¶
Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut 
labore et dolore magna aliqua.
Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut 
labore et dolore magna aliqua.
¶
Title
Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut 
labore et dolore magna aliqua.

Title 
dof
Document

Introduction
(optional) 
Arial Bold
size: 10 pt
spacing: 12 pt

Title
Arial Bold
size: 10 pt
spacing: 12 pt

Text
Arial Regular
size: 10 pt
spacing: 12 pt

Project in short 
(called Progetto breve)

4

5

1

2

3

Sender’s field
(when not stated in the 
header) and object 
Arial Bold
size: 10 pt
spacing: 12 pt

Title
Arial Bold
size: 21 pt
spacing: 21 pt

Use Elements 
layout

4

5

1

2

3

Brief overview 
of the structure of 
information on 
the various media.
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1.

2.

Università
della
Svizzera
italiana

Agenda/Minutes

Date, author
¶
¶
Date of the meeting	 Day month year
Place	 XX
Participants	 •	 Name surname 1
	 •	 Name surname 2
	 •	 Name surname 3
Excused	
Agenda	 1.	 Topic discussed 1
	 2.	 Topic discussed 2
	 3.	 Topic discussed 3
¶
¶
Topic discussed
Text

Column 1	 Column 2	 Column 3
¶
¶
Topic discussed
Text
¶

Column 1			   Column  2

Title
of the
meeting

Date, author 
Arial Regular
size: 10 pt
spacing: 12 pt

Bullet points
can be edited via 
the list of styles

Columns can be 
edited as needed.

Agenda-minutes

4

6

6

5

5

1

2

3

4

6

5

Action/Decision Reference person By the (date)

Action/Decision Reference person

Use Elements 
layout

Brief overview 
of the structure of 
information on 
the various media.

Header
-	 University
-	 University + Faculty
-	 University + Institute

Sender’s field
(when not stated in the 
header) and object 
Arial Bold
size: 10 pt
spacing: 12 pt

Title
Arial Bold
size: 21 pt
spacing: 21 pt

1

2

3
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04.05.2022, Autore, versione nr. 000 

Servizio o unità organizzativa 

Titolo  
del  
documento 
 
 
 

Date, author 
Arial Regular
size: 10 pt
spacing: 12 pt

Project with cover 
(called Progetto con copertina)

Use Elements 
layout

4

1

2

3

Header
-	 University
-	 University + Faculty
-	 University + Institute

Sender or subject field
Arial Bold
size: 10 pt
spacing: 12 pt

Title
Arial Bold
size: 40 pt
spacing: 42 pt

1

2

3

Brief overview 
of the structure of 
information on 
the various media.
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pagina 2 / 13  
 

Indice 

 
1. Titolo 1 3 

1.1. Titolo 1.1 4 
1.1.1. Titolo 1.1.1 4 

1.1.1.1. Titolo 1.1.1.1 4 
1.1.1.2. Titolo 1.1.1.2 4 

2. Titolo 4 5 
2.1. Titolo 4.1 5 
2.2. Titolo 4.2 5 

2.2.1. Titolo 4.2.1 5 
2.2.2. Titolo 4.2.2 5 

3. Titolo 2 8 
3.1. Titolo 2.1 8 
3.2. Titolo 2.2 8 

3.2.1. Titolo 2.2.1 9 
3.2.2. Titolo 2.2.2 9 

4. Titolo 3 12 
4.1. Titolo 3.1 12 
4.2. Titolo 3.2 12 

4.2.1. Titolo 3.2.1 13 

Index
Arial Regular
size: 10 pt
spacing: 12 pt

5 5

Project with cover 
(called Progetto con copertina)

Use Elements 
layout

Brief overview 
of the structure of 
information on 
the various media.

page 2 / 13

1.	 Title 1	
	 1.1.	 Title 1.1
		  1.1.1.	 Title 1.1.1
			   1.1.1.1.	 Title 1.1.1.1

2.	 Title 4	
	 2.1.	 Title 4.1
		  2.2.	 Title 4.2
			   2.2.1.	 Title 4.2.1
			   2.2.2.	 Title 4.2.2

3.	 Title 2
	 3.1.	 Title 2.1
	 3.2.	 Title 2.2
		  3.2.1.	 Title 2.2.1
		  3.2.2.	 Title 2.2.2

4.	 Title 3
	 4.1.	 Title 3.1
	 4.2.	 Title 3.2
		  4.2.1.	 Title 3.2.1

Index
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1. Titolo 1 
consectetuer adipiscing elit. Aenean commodo ligula eget dolor. Aenean massa. Cum sociis 
natoque penatibus et magnis dis parturient montes, nascetur ridiculus mus. Donec quam 
felis, ultricies nec, pellentesque eu, pretium quis, sem. Nulla consequat massa quis enim. 
Donec pede justo, fringilla vel, aliquet nec, vulputate eget, arcu. In enim justo, rhoncus ut, 
imperdiet a, venenatis vitae, justo. Nullam dictum felis eu pede mollis pretium. Integer 
tincidunt. Cras dapibus. Vivamus elementum semper nisi. Aenean vulputate eleifend tellus. 
Aenean leo ligula, porttitor eu, consequat vitae, eleifend ac, enim. Aliquam lorem ante, 
dapibus in, viverra quis, feugiat a, tellus. Phasellus viverra nulla ut metus varius laoreet. 
Quisque rutrum. Aenean imperdiet. Etiam ultricies nisi vel augue. Curabitur ullamcorper 
ultricies nisi. Nam eget dui. Etiam rhoncus. Maecenas tempus, tellus eget condimentum 
rhoncus, sem quam semper libero, sit amet adipiscing sem neque sed ipsum. Nam quam 
nunc, blandit vel, luctus pulvinar, hendrerit id, lorem. Maecenas nec odio et ante tincidunt 
tempus. Donec vitae sapien ut libero venenatis faucibus.  
 
Nullam quis ante. Etiam sit amet orci eget eros faucibus tincidunt. Duis leo. Sed fringilla 
mauris sit amet nibh. Donec sodales sagittis magna. Sed consequat, leo eget bibendum 
sodales, augue velit cursus nunc, quis gravida magna mi a libero. Fusce vulputate eleifend 
sapien. Vestibulum purus quam, scelerisque ut, mollis sed, nonummy id, metus. Nullam 
accumsan lorem in dui. Cras ultricies mi eu turpis hendrerit fringilla. Vestibulum ante ipsum 
primis in faucibus orci luctus et ultrices posuere cubilia Curae; In ac dui quis mi consectetuer 
lacinia. Nam pretium turpis et arcu. Duis arcu tortor, suscipit eget, imperdiet nec, imperdiet 
iaculis, ipsum. Sed aliquam ultrices mauris. Integer ante arcu, accumsan a, consectetuer 
eget, posuere ut, mauris. Praesent adipiscing. Phasellus ullamcorper ipsum rutrum nunc. 
Nunc nonummy metus. Vestibulum volutpat pretium libero. Cras id dui. Aenean ut eros et 
nisl sagittis vestibulum. Nullam nulla eros, ultricies sit amet, nonummy id, imperdiet feugiat, 
pede. Sed lectus. Donec mollis hendrerit risus. Phasellus nec sem in justo pellentesque 
facilisis. Etiam imperdiet imperdiet orci. Nunc nec neque.  
 

 
Phasellus leo dolor, tempus non, auctor et, hendrerit quis, nisi. Curabitur ligula sapien,  
  

Caption 
Arial Regular
size: 7.5 pt
spacing: 9 pt

6 6

Project with cover 
(called Progetto con copertina)

Use Elements 
layout

Brief overview 
of the structure of 
information on 
the various media.
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1.1. Titolo 1.1  
Maecenas vestibulum mollis diam. Pellentesque ut neque. Pellentesque habitant morbi 
tristique senectus et netus et malesuada fames ac turpis egestas. In dui magna, posuere 
eget, vestibulum et, tempor auctor, justo. In ac felis quis tortor malesuada pretium. 
Pellentesque auctor neque nec urna.  
 
1.1.1. Titolo 1.1.1  

Aenean viverra rhoncus pede. Pellentesque habitant morbi tristique senectus et netus et 
malesuada fames ac turpis egestas. Ut non enim eleifend felis pretium feugiat. Vivamus quis 
mi. Phasellus a est. Phasellus magna. In hac habitasse platea dictumst.  

• Curabitur at lacus ac velit ornare lobortis.  
• Curabitur a felis in nunc fringilla tristique.  
• Morbi mattis ullamcorper velit.  
• Phasellus gravida semper nisi.  

• Nullam vel sem.  
• Pellentesque libero tortor, tincidunt et, tincidunt eget, semper nec, quam.  
• Sed hendrerit. Morbi ac felis. Nunc egestas, augue at pellentesque laoreet, felis eros 

vehicula leo, at malesuada velit leo quis pede.  
Donec interdum, metus et hendrerit aliquet, dolor diam sagittis ligula, eget egestas libero 
turpis vel mi. Nunc nulla. Fusce risus nisl, viverra et, tempor et, pretium in, sapien. Donec 
venenatis vulputate lorem. Morbi nec metus. Phasellus blandit leo ut odio. Maecenas 
ullamcorper, dui et placerat feugiat, eros pede varius nisi, condimentum viverra felis nunc et 
lorem. Sed magna purus, fermentum eu, tincidunt eu, varius ut, felis. In auctor lobortis lacus.  
 
1.1.1.1. Titolo 1.1.1.1  

Vestibulum ullamcorper mauris at ligula. Fusce fermentum. Nullam cursus lacinia erat. 
Praesent blandit laoreet nibh. Fusce convallis metus id felis luctus adipiscing. Pellentesque 
egestas, neque sit amet convallis pulvinar, justo nulla eleifend augue, ac auctor orci leo non 
est. Quisque id mi. Ut tincidunt tincidunt erat. Etiam feugiat lorem non metus. Vestibulum 
dapibus nunc ac augue.  
 
1.1.1.2. Titolo 1.1.1.2 

Praesent egestas neque eu enim. In hac habitasse platea dictumst. Fusce a quam. Etiam ut 
purus mattis mauris sodales aliquam. Curabitur nisi. Quisque malesuada placerat nisl. Nam 
ipsum risus, rutrum vitae, vestibulum eu, molestie vel, lacus. Sed augue ipsum, egestas nec, 
vestibulum et, malesuada adipiscing, dui. Vestibulum facilisis, purus nec pulvinar iaculis, 
ligula mi congue nunc, vitae euismod ligula urna in dolor. Mauris sollicitudin fermentum 
libero.  

1. Praesent nonummy mi in odio.  
2. Nunc interdum lacus sit amet orci.  
3. Vestibulum rutrum,  

a. mi nec elementum vehicula,  
b. eros quam gravida nisl,  

̶ id fringilla neque  
̶ ante vel mi.  

 
  

Text
Arial Regular
size: 10 pt
spacing: 12 pt

For titles 
and lists 
use preset styles

7 7

Project with cover 
(called Progetto con copertina)

Use Elements 
layout

Brief overview 
of the structure of 
information on 
the various media.
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Caption 
Arial Regular 
size: 7.5 pt
spacing: 9 pt

Quote
Arial Regular 
Arial Bold 
size: 10 pt 
spacing: 12pt 

between two lines 

8 8

9 9

pagina 7 / 13 
 

 
Aenean posuere, tortor sed cursus feugiat, nunc augue blandit nunc, eu sollicitudin urna dolor sagittis lacus.  
 
Donec elit libero, sodales nec, volutpat a, suscipit non, turpis. Nullam sagittis. Suspendisse 
pulvinar, augue ac venenatis condimentum, sem libero volutpat nibh, nec pellentesque velit 
pede quis nunc. Vestibulum ante ipsum primis in faucibus orci luctus et ultrices posuere 
cubilia Curae;  
 
Ut varius tincidunt libero. Phasellus dolor. Maecenas vestibulum mollis diam. Pellentesque ut 
neque. Pellentesque habitant morbi tristique senectus et netus et malesuada fames ac turpis 
egestas. In dui magna, posuere eget, vestibulum et, tempor auctor, justo. In ac felis quis 
tortor malesuada pretium. Pellentesque auctor neque nec urna. Proin sapien ipsum, porta a, 
auctor quis, euismod ut, mi. Aenean viverra rhoncus pede. Pellentesque habitant morbi 
tristique senectus et netus et malesuada fames ac turpis egestas. Ut non enim eleifend felis 
pretium feugiat. Vivamus quis mi. 
 
 

 
 
 
Vestibulum fringilla pede sit amet augue. In turpis. Pellentesque posuere. Praesent turpis. 
Aenean posuere, tortor sed cursus feugiat, nunc augue blandit nunc, eu sollicitudin urna 
dolor sagittis lacus. Donec elit libero, sodales nec, volutpat a, suscipit non, turpis. Nullam 
sagittis. 
 
 
Autore 1 
Nome Cognome 
Funzione 

Autore 3 
Nome Cognome 
Funzione 

Nome Cognome 
Ruolo 
Azienda 
“(QUOTE) Offering a good balance between technical 
and practical learning. Being organised with clear and 
effective lectures and adequate resources to support the 
preparation.“ 

1st Qtr 2nd Qtr 3rd Qtr 4th Qtr

5

Project with cover 
(called Progetto con copertina)

Use Elements 
layout

Brief overview 
of the structure of 
information on 
the various media.
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The folders are divided 
by: USI organisational 
units, Faculties, 
Institutes, Services, etc. 

Word templates
user guide

Where and how 
to access files

Please note
It is always 
recommended to start 
with a new document.

The templates are 
subject to changes and 
improvements, so they 
will always be updated.

Organisationl units
Templates

New document 
On the main page when  
we want to open a new 
document find the shared 
folder, sorted by file type:

5

3

Letterhead
Templates

Labels
Templates

Email signature
Templates

1 1

2

4

When opening Word, a blank document appears by default.
1.	 Click on “File”, and then “New”.
2.	 Folders with available USI templates are displayed.

Other ways to access files

In the share folder  “USI Documentazione e Modelli”.
	 from the Lugano campus network: copy and paste the address    

“\\usi.usilu.net\dfs\USI-Documentazione e Modelli\Modelli” on the system browser   
	 The folder  “\\usi\dfs\USI-Documentazione e Modelli”  can also by accessed from  ‘This PC’ in the R disk.

	 	from outside the Lugano campus network, it is required to activate the USI VPN and connect to the route   
“\\usi.usilu.net\dfs\USI-Documentazione e Modelli\Modelli”. 

	 In serviceportal.usi.ch the full guide to accessing USI documents from outside the campus network via VPN 
(from PC and Mac) is included  https://vpn.usi.ch  

file:\\usi\dfs\USI-Documentazione%20e%20Modelli
http://serviceportal.usi.ch
https://vpn.usi.ch
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Text Styles

In order to maintain 
the correct graphic 
consistency, as well as 
a pleasant and clear 
reading experience, it 
is recommended to 
use the preset styles.

Available in the toolbar 
(Home  Styles  
or by typing 
Alt+Ctrl+Shift+S).

The use of other fonts 
or colours is not 
allowed.

The text is left-aligned. 
Please avoid 
hyphenation. 

Preset styles

 
1 1

Styles 
preview

3 3

4Click on
Show Preview
for a preview 
of the styles

4

Styles 
dialogue box

2 2
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Text Styles

Stili disponibili che 
potreste trovare nella 
finestra.

Basic styles1

Bulleted list4

Link7

Quote / highlights8

Titles 
without numbering

2

Titles 
with numbering

3

Mixed numbered and 
bulleted list

5

Numbered list6

Table9

		  Used for a project’s cover title.

		  Used for the running text.

		  Used to differentiate words in another language or to place emphasis on a particular 
term. It does not apply to words in other commonly used languages (Bachelor, Honoris 
causa, etc).

	  Used to highlight a paragraph.

		  Used to describe images or charts (captions).

		  Used for the sender in letterheads.

		  Used for footnotes.

		  Used for subtitles, supertitles, an object or an organisational unit.

		  Used for signatures at the end of the document (Project with cover and Short Project).

		  Style also suited to short introductory texts.

		  It is possible to highlight a testimony or concept.

	 Links are automatically underlined when they are set.

		  Index-linked titling that is automatically generated
		  Helps prioritise chapters and sub-chapters.
		  Through the buttons                  it is possible to change the numbering 

quickly and easily.

		  Helps prioritise lists and bullet points using a varied system of numbers, 
letters, dots, etc.

		  Through the buttons                 it is possible to change the numbering 
quickly and easily.

		  Helps prioritise lists and bullet points using a varied system of numbers, 
letters, dots, etc.

		 Through the buttons                 it is possible to change the numbering 
quickly and easily.

		  These are the styles to be used in tables (USI Table Style).

		  Through the buttons   	         it is possible to change the numbering 

		  Helps prioritise lists and bullet points
		  Through the buttons 	        it is possible to change the numbering 

quickly and easily.
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Copy/Paste

We often do not write the text entirely or directly in the final word document but must import data from another 
source (pre-existing document, email, etc.).

In most cases, our aim is not to lose formatting (images, italics, bold, titling, etc.), which is why the simple CTRL + 
C / CTRL + V often does not allow us to do this as desired.

In Word, you can paste text using source, target or simply plain text formatting (see page 17).
If you always want one of the options, follow some simple steps to set it as the default for pasted text.

Changing options when pasting content

When copying content from a formatted source, such as a web page or other Word document, you can select 
options when pasting it into the document.

1. 	 Tap or click where you want to paste the content.
2.	 Press CTRL + V and then select Paste Options   .
3.	 Place the mouse over the buttons, you will immediately see how the text behaves directly on the document.
4.	 Select the best option for you.

More information and insights here qui.

Please note
Following each paste, it is recommended to re-assign the predefined styles to each element
(titles, numbering, bullet points, etc).

https://support.microsoft.com/it-it/office/controllare-la-formattazione-quando-si-incolla-il-testo-20156a41-520e-48a6-8680-fb9ce15bf3d6
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Source file

Select the 
sheet

1 1

2 2

Word templates
user guide

Mail merge

Mail merge lets you create a batch of documents that are personalised for each recipient. To use mail 
merge for letters and labels a data source file is merged with a target document.

Before starting, it is important to have the list of recipients on an Excel spreadsheet (source file) filled in 
orderly and correctly and with the fields well divided.

Upload the source file
from the menu bar
 Mailings
 Select Recipients

2 2
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Mail merge

Insert Merge Field
from menu
  Mailings
  Insert Merge Field

Enter the address in the 
field.

It is possible to enter the 
same data within the letter 
as per the example.

Finish and Merge
From Mailing 
 Finish & Merge 
 Edit individual 
Documents.

A window
Merge to New Document 
will open
 flag All records 
click Ok

The new document to 
save and print with 
addresses and names 
will open.

Save the main file for future
use.

3

4

5

5

6

6

5

5

3

4
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Source file1 1

Word templates
user guide

Mail merge

Mail merge lets you create a batch of documents that are personalised for each recipient.  
To use mail merge for letters and labels a data source file is merged with a target document.

Before starting, it is important to have the list of recipients on an Excel spreadsheet (source file)  
filled in orderly and correctly and with the fields well divided.

Choose the label 
vendor or model

3 3

Open a document 
(blank page)
Choose from
  Mailings
  Start Mail Merge
  Labels

2 2

Upload source
  Mailings
  Select Recipients
  Use an Existing List

4 4

Select the sheet5 5

Two labels template are 
available (for letters and 
for parcels), wich can be 
found in the “labels” folder 
displayed when opening a 
new Word document.
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Stampa
unione

A window Merge to  
New Document will open
 seleziona All records 
 clicca su Ok

The new document to 
save and print with 
addresses and names 
will open.

Save the main file 
for future use.

8

9

10

11

10

11

9

Insert Merge Field
from menu 
  Mailings
  Insert Merge Field

Insert address in the field.

It is possible to enter the 
same data within the letter 
as per the example 

Insert Merge Field
from menu 
  Mailings
  Insert Merge Field

Enter the address in the field.

It is possible to enter the same 
data within the letter as per the 
example 

Finish and Merge
from Mailing menu
  Finish & Merge 
  Edit individual Documents.

6

7

6

7 8

Two labels template are 
available (for letters and 
for parcels), wich can be 
found in the “labels” folder 
displayed when opening a 
new Word document.
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Select the text
to which you wish to 
change the orientation 
from vertical to 
horizontal.

In this case, allow more 
space to the columns.

1

Word templates
user guide

Page orientation

1

From the Layout menu 
(by clicking on the icon at 
the bottom right)  
open the dialogue box
Page Setup dialogue box.
  

From the Page Setup 
dialogue box, select  
the orientation from 
portrait to landscape.

Apply to Selected text. 
Click OK.

2

3

4

2

3

4
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Using the angle of the 
box, stretch the table as 
needed over the width of 
the document now 
oriented horizontally.

5 5

At this point the page has 
changed orientation, but 
with the header on the 
first page. To replace it, 
double-click on the 
header or from the menu:
Insert  Header  Edit

The Design tab opens. 
Uncheck the item 
Different First Page

6

7

6

7

Word templates
user guide

Page orientation
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8

10 10

9

8 9

Word templates
user guide

Page orientation

L’header si aggiorna 
automaticamente.

Final reesult.

Close the Design 
dialogue box
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Numbering continues 
from the previous 
paragraph

Double-click on the 
numbered paragraph
(click on the number itself)

Right click on 
Restat at 1.

1

2

3

1

2

3

Word templates
user guide

List
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List

Paragraph numbering  
will start again from 1.

Selecting Continue from 
previous list and Advance 
value you can set the 
start numbering 
preferences.

4

6

4

6

To change the multi-point 
numbering, click on the 
number
of the paragraph, 
right-click and choose 
Set Numbering Value.

The same logic 
should also be 
applied to more 
complex 
numbering

5 5
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It is possible to combine 
bullets and numbers, 
here are some examples.

Change level of a list of 
tthe same ‘family’.

1

1

1

1

Word templates
user guide

List

Bulleted points  
can be combined.
 

Their use helps to 
prioritise information 
within the text.
 

With               (1) it is 
possible to change the 
degree of numbering 
quickly and easily. 
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with cover

The index  
is generated using 
Heading 1-4 styles

The number of title levels 
can be set from the 
menu:
 References
 Table of Contents 
 Custom Table of  
    Content

In General enter the 
desidered number of 
levels.
< 1 level
> 4 level

1

2

3

1

2

3

Word templates
user guide

Index
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To automatically create 
the index, click
 Update Table
 Update entire table

This step also applies  
to updates if there are 
changes to the titles.

3 3

Project  
with cover

Word templates
user guide

Index
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This option is only 
possible in documents 
structured with styles.

Structure

How to move entire 
chapters without 
losing data, quickly 
and easily.

On the View menu 
check Navigation Pane.

A dialogue box 
will open with the
document structure.

1

2

1

2

Word templates
user guide

Moving 
full chapters
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Questa opzione è 
possibile unicamente 
nei documenti 
strutturati con gli stili.

Structure

Come spostare interi 
capitoli senza perdere 
dati, in modo semplice 
e veloce.

Word templates
user guide

Moving 
full chapters

Drag the selected 
chapter to the desired
position.

The entire chapter 
including subtitles are 
now where we wanted 
them to be.

3

4

3

4



40

	 Footnotes



41 Word templates
user guide

Footnotes

From Reference menu
Insert the note where 
needed.

1 1

1

1

The text box is 
automatically created. 
Each footnote will be 
placed on the same 
reference page.

2

2

2

2
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Colours

The only themes to be 
used are the first two: 
USI-Theme (greyscale) 
or Faculty-Theme
(colour).

All charts will be 
displayed according  
to the chosen theme.

1

2

2

2

1

2
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Colours

To edit a single chart
 select the box
 click on the brush
 select Color
 choose the desired 
    colour scale

3 3

4 4
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Drawing a table

Show paragraph marks 
and formatting symbols

Divide text using tabs to 
identify columns.

1

2

1

3

3

2

From Insert menu, 
select Convert text
 to table.

3

3
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Drawing a table

From the dialogue box 
separate text at 
select Tab

4

5

4

4

Columns will be 
automatically created  

5
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Drawing a table

In order to maintain 
the correct graphic 
consistency, as well as 
a pleasant and clear 
reading experience, it 
is recommended to 
use the preset styles,

available in the toolbar 
(Home  Styles or 
typing 
Alt+Ctrl+Shift+S).
 

The use of other fonts 
and colours is 
discouraged.
 

The text is left-aligned. 
Please avoid 
hyphenation. 

By dragging the mark 
with the two arrows 
(which appears at the 
beginning of each 
column, within the of the 
table), the columns can 
be modified as desired.

This applies to both width 
and height.

6

7

6

Table styles can be 
chosen from the Design 
menu (by selecting the 
table).

Prefere USI Table Style

7
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Importing 
a table 
fromExcel

Similar steps when 
importing a table from 
Microsoft Excel

Open the Excel file 

Select only the desired 
cells and copy them  
(Ctrl + C)

1

2

2

1

From the Home menu, 
click on the small arrow 
below the Paste icon.

Choose
Paste Special

The text will be copied 
where the cursor is 
located

2

2
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Importing 
a table 
fromExcel

From the pop-up window, 
in this case, choose 
Unformatted text.

3

4

3

The text will be inserted 
separated by Tab.
The text will be spread 
over several pages in 
the case of long lists.

4
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Importing 
a table 
fromExcel

The programme 
automatically detects 
the number of columns

7 7
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Contatti
Institutional Communication Service
Università della Svizzera italiana
Via Buffi 13
6900 Lugano
Switzerland

e-mail corporate-design@usi.ch
web www.usi.ch

© Università della Svizzera italiana

At this stage you can 
choose the appearance 
desired, using the 
predefined styles.
See previous chapters.

8 8

mailto:corporate-design%40usi.ch?subject=
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